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MicroStrategy Object 
Manager Concepts 1

MicroStrategy Object Manager provides complete life cycle management 
capabilities for a MicroStrategy environment. Object management involves 
maintenance of all application, schema, and configuration objects within and 
across related projects in an intuitive and fault-tolerant manner. MicroStrategy 
Object Manager lets you set up these related projects in multiple environments 
easily, by enabling you to copy elements that are already developed.

MicroStrategy Object Manager uses many of the same concepts, interfaces, and 
procedures as MicroStrategy Desktop, so you should be familiar with Desktop 
fundamentals before using Object Manager or its documentation. For more 
information on Desktop fundamentals, see the MicroStrategy Getting Started 
Guide.

Why use MicroStrategy Object Manager?
A typical application progresses through several stages before it is considered 
ready for production. Each stage has its own related MicroStrategy project. The 
stages are usually

• Development, where objects are created for the first time

• Test, where objects are tested and verified, or certified

• Production, which contains only certified objects and where the data they 
access is live

MicroStrategy Object Manager is the tool you use to promote objects from one 
stage, or project, to the next, by letting you copy an object or group of objects from 
one project to another. You can also copy and move objects within the same 
project. 
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MicroStrategy Object Manager services
MicroStrategy Object Manager allows you to:

• duplicate and upgrade projects

• copy and paste objects within a project

• copy and paste objects across related projects

• move objects within a project

• delete objects within a project

• rename objects within a project

• search for objects within a project

• find an object’s parents or children within a project

Setting up your environment
To perform operations across projects, MicroStrategy Object Manager requires 
that the projects involved be created from the same source project. This ensures 
that they have a similar set of schema and application objects and that the object 
IDs in the two projects are the same. MicroStrategy Object Manager uses the same 
object IDs and their version IDs across the projects to perform comparisons.

For example, usually at least two versions, Development and Production, of the 
same project are created, and sometimes a third, Testing. To use these projects 
with MicroStrategy Object Manager, one project, usually Production, must be set 
up first. Then the others are created by duplicating that initial site. 

How copying works in MicroStrategy Object 
Manager

The copy command duplicates all the selected objects in the source location to the 
target location. However, exactly how that is accomplished depends on the 
situation, for example whether the object is copied within a single project or from 
one project to another.

The terms defined below are used throughout this section, so you should become 
familiar with them.
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MicroStrategy Object Manager operations may involve the following objects:

• Application objects include consolidations, custom groups, documents, 
filters, metrics, prompts, reports, searches, templates, and folders.

• Configuration objects include database instances, schedules, users, and user 
groups.

• Schema objects include attributes, facts, functions, hierarchies, tables, and 
transformations.

These objects are classified one of the following nine ways based on their location 
during an Object Manager operation. The classification determines in which 
folder Object Manager saves an object. It also helps to resolve conflicts during an 
operation.

• Base object is the top-level object, the item you selected from the interface 
during an Object Manager operation.

• Base folder is the top-level folder, the folder you selected during an Object 
Manager operation.

• Base user group is the top-level user group, the user group you selected during 
an Object Manager operation.

• Base user is the top-level user, the user you selected during an Object Manager 
operation.

• Child folder is a folder located in a base folder or in another child folder.

• Child group is any group located in a base or child group.

• Child object is any object that is located in a base folder or in another child 
folder. For example, if the Reports folder is selected to be copied, the Reports 
folder is the base object and all the objects inside the Reports folder are the 
child objects. 

• Child user is any user in a base or child group.

• Dependent object is any object that is retrieved from the dependency list of 
each base or child object. For example, a report is a base object that has a 
template and a filter as dependent objects.

Duplicating projects

Projects created in MicroStrategy 7 can be duplicated in the same project source 
or in a different one. MicroStrategy Object Manager activates MicroStrategy 
Desktop Project Duplication wizard to perform the operation. 

A project created in MicroStrategy 6.x cannot be duplicated until it is upgraded to 
a 7.x project in a 7.x project source. MicroStrategy Object Manager activates the 
MicroStrategy Desktop Project Upgrade wizard to perform the upgrade. 

A direct (two-tier) connection to the source and destination project sources is 
required, whether the project is duplicated or upgraded. 
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Copying objects within a project

The simplest copying scenario is one in which the source and target projects are 
the same. The MicroStrategy Object Manager copy function performs in a manner 
similar to that of MicroStrategy Desktop. 

&RS\LQJ�DSSOLFDWLRQ�DQG�VFKHPD�REMHFWV�ZLWKLQ�D�SURMHFW

When copying application and schema objects within a project, MicroStrategy 
Object Manager behaves exactly as Desktop does. Remember that a base object is 
the object you select from the interface during an Object Manager operation.

Object
classification

Destination 
directory

Action Name of 
copied object

Base object 
(application or 
schema object)

Same as source Copy identically Copy of source 
name

Different from 
source

Copy identically Source name

Base folder Same as source Copy identically Copy of source 
name

Different from 
source, and not a 
subdirectory of 
source

Copy identically Source folder name

If that already 
exists, Copy of 
source folder name

Subdirectory of 
source

Warning message 
displayed; cannot 
copy folder

N/A

Dependent objects N/A No action N/A

Child objects and 
folders

Remain within copy 
of base folder in 
destination location

Copy identically Source object/folder 
name
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&RS\LQJ�FRQILJXUDWLRQ�REMHFWV�ZLWKLQ�D�SURMHFW

Configuration objects include database instances, schedules, users, and user 
groups. During a copy operation, database instances and schedules are handled 
differently from users and user groups.

Copying across projects

To perform copy operations across projects, the projects involved must be derived 
from the same source project. To set up your environment to work with 
MicroStrategy Object Manager, please see the topic Setting up your environment.

Object
classification

Destination 
directory

Action Name of 
copied object

Base object 
(database instance 
or schedule)

Can only be the 
same as source

Copy identically Copy of source 
name

Base user/group Same as source 
group

Copy identically Copy of source 
user/group name

Different from 
source group

Destination group is 
added to source 
user/group 
membership

N/A
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&RS\LQJ�EDVH�DSSOLFDWLRQ�DQG�VFKHPD�REMHFWV�DFURVV�

SURMHFWV

Remember that a base object is the object you select from the interface during an 
object management operation.

Conflict resolution table

Object
classification

Object
conflict?

Action Name of 
copied object

Base object (all 
application and 
schema objects 
except folders)

No, object does not 
exist in destination

Copy identically to 
destination location

Source object name

If an object of that 
name and type 
already exists, 
Source object name 
(1...n)

Yes, object exists 
identically (same 
version)

See the conflict resolution table

Yes, object exists 
differently (different 
version)

See the conflict resolution table

User interaction Action Name of copied 
object

Use existing No change to destination 
object

N/A

Keep both No change to destination 
object

Source object duplicated in 
destination location

If new name specified, 
Specified object name

If another object of that 
name and type already 
exists, Specified object 
name (1...n)

If new name not specified, 
New version of Source 
object name
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Dependent objects, folders, and child objects are handled differently from the base 
object copy described above. See the appropriate topics in this chapter for detailed 
information.

Replace Destination object replaced 
with source object and 
relocated to new location if 
destination location is 
different from the current 
location

If new name specified, 
Specified object name

If another object of that 
name and type already 
exists, Specified object 
name (1...n)

If new name not specified, 
Source object name

Use newer (based on 
modification date)

If source object is newer 
than destination object, 
Replace action is used

If new name specified, 
Specified object name

If another object of that 
name and type already 
exists, Specified object 
name (1...n)

If new name not specified, 
Source object name

If source object is not newer 
than destination object,  
Use existing action is used

N/A

Use older (based on 
modification date)

If source object is newer 
than destination object, Use 
existing action is used

N/A

If source object is not newer 
than destination object, 
Replace is used

If new name specified, 
Specified object name

If another object of that 
name and type already 
exists, Specified object 
name (1...n)

If new name not specified, 
Source object name

User interaction Action Name of copied 
object
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FRSLHG�DFURVV�SURMHFWV

A dependent object is any object that is retrieved from the dependency list of each 
base or child object. 

&RS\LQJ�EDVH�IROGHUV�DFURVV�SURMHFWV

A base folder is a top-level folder, the folder that you selected from the interface 
during the copy.

Object
conflict?

Action Name of 
copied object

No, dependent object does 
not exist in destination

If the relative dependent 
source location exists in the 
destination project, copied 
identically in relative 
destination location of 
source object

If it does not, copied into a 
new folder titled 
Dependents in the 
destination location

Source object name

Yes, dependent object 
exists identically (same 
version)

No action N/A

Yes, dependent object 
exists differently (different 
version)

See the conflict resolution table

Object
Conflict?

Action Name of
Copied Object

No, folder does not exist in 
destination

Copy identically Source folder name

Yes, folder exists. Source 
and destination paths are 
the same

In Conflict Resolution dialog 
box, if you select Update 
destination folder name in 
same path, the existing 
folder is updated with the 
new objects from the copy 
operation. 

N/A
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A child folder is a folder that is located within the base folder or one of its child 
folders.

Yes, folder exists, but 
source and destination 
paths are different (base 
folder exists in the 
destination project but in a 
different location)

In Conflict Resolution dialog 
box, if you select Update 
destination folder name in 
same path, the existing 
folder is updated with the 
new objects from the copy 
operation. 

N/A

If you select Update 
destination folder name in 
new path, 

• the folder moves to the 
new destination location; 
any new objects are 
copied into it

• If the destination location 
is a subfolder of the 
existing folder, the folder 
cannot be moved and an 
error message is 
displayed.

N/A

Object
conflict?

Action Name of
copied object

No, folder does not exist in 
destination

Create a new folder in the 
destination location

Source child folder name

Yes; source and destination 
paths are the same

In the Conflict Resolution 
dialog box, if you choose 
Update destination folder 
name in same path, the 
existing folder is updated 
with the new objects from 
the copy operation.

N/A

Object
Conflict?

Action Name of
Copied Object
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&KLOG�REMHFWV�RI�EDVH�IROGHUV�FRSLHG�DFURVV�SURMHFWV

A child object is any object that is located within the base folder or in one of its 
child folders.

&RS\LQJ�FRQILJXUDWLRQ�REMHFWV�DFURVV�SURMHFWV

Configuration objects include database instances, schedules, users, and user 
groups. During a copy operation, database instances and schedules are handled 
differently from users and user groups. 

Yes; source and destination 
paths are different (child 
folder exists in the 
destination project but in a 
different location)

If you choose Update 
destination folder name in 
same path, the existing 
folder is updated with the 
new objects from the copy 
operation.

N/A

If you choose Update 
destination folder name in 
new path,

• the folder moves to the 
new destination location

• any new objects are 
copied into it

N/A

Object
conflict?

Action Name of
copied object

No, object does not 
exist in destination

Copy identically to 
destination location 
within base or child 
folder

Source object name

If an object of that name and type 
already exists, Source object name 
(1...n)

Yes, object exists 
identically (same 
version)

See the user/group conflict resolution table.

Yes, object exists 
differently (different 
version)

See the user/group conflict resolution table.

Object
conflict?

Action Name of
copied object
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&RS\LQJ�GDWDEDVH�LQVWDQFHV�DQG�VFKHGXOHV�DFURVV�SURMHFWV

Copying database instances and schedules works the same as copying base 
application and schema objects. The single difference is that configuration objects 
can be copied only into their respective folders. For example, database instances 
can be copied only into the Database Instance Manager folder, and schedules can 
only be copied into the Schedule Manager folder.

1RWH��You are strongly discouraged from replacing database instances across 
projects. Database instances are usually different for different projects. For 
example, the development project typically points to the development warehouse 
while the production project uses the production warehouse. In these cases, 
replacing the database instance greatly affects all aspects of a project, since the 
database instance is the foundation for the application.

Dependent objects of database instances—Dependent objects of database 
instances include database management systems, database logins, and database 
connections. All of these are integral to identifying the database instance, so they 
are copied with the database instance. None of them appear in the Conflict 
Resolution dialog box. 

Dependent objects of schedules—Schedules have only events as dependents. 
Events are copied automatically with their parent schedule. Events never appear 
in the Conflict Resolution dialog box.
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&RS\LQJ�XVHUV�DQG�XVHU�JURXSV�DFURVV�SURMHFW�VRXUFHV

Copying users works similarly to copying application and schema objects. 
However, there are a few differences, outlined as follows:

• Since users are located at the project source level, all the projects that exist in 
the same project source may share the same user or group. 

• Groups may be children of other groups, yet are not dependent objects.

User/group conflict resolution table

Object
conflict?

Action Name of
copied object

No, user does not exist 
in destination

Copy identically

If the destination group 
is not included in 
group memberships, it 
is added to them.

Source user name 

Yes, user exists 
identically (same 
version)

See the user/group conflict resolution table.

Yes, user exists 
differently (different 
version)

See the user/group conflict resolution table.

User interaction Action Name of copied object

Use existing No change to destination N/A

Replace Destination user/group 
definition replaced with 
source user/group definition

If the destination group is 
not included in source 
user/group memberships, it 
is added to them.

If new name specified, then 
Specified new name; if name 
already exists then New 
specified object name (1)

Otherwise name stays the 
same.

Merge memberships Destination user/group 
membership information 
modified to reflect the 
current content of both the 
source and destination 
user/group

If the destination group is 
not included in user/group 
memberships, it is added to 
them.

N/A
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&RS\LQJ�EDVH�JURXSV�DFURVV�SURMHFWV

A base group is a top-level group, the group that you select from the interface 
during the copy. 

&KLOG�XVHUV�JURXSV�RI�XVHUV�FRSLHG�DFURVV�SURMHFWV

A child user is any user located in the base group or in one of its child groups. A 
child group is any group that is located in the base group or in one of its child 
groups.

Object
conflict?

Action Name of
copied object

No, group does not 
exist in destination

Create a new group in 
the destination

If the destination group 
is not included in 
group memberships, it 
is added to them.

Source group name

Yes, group exists 
identically (same 
version)

See the user/group conflict resolution table in the topic Copying 
users and user groups across projects

Yes, group exists 
differently (different 
version)

See the user/group conflict resolution table in the topic Copying 
users and user groups across projects

Object
conflict?

Action Name of
copied object

No, user/group does 
not exist in destination

Copy identically Source user/group name

Yes, user/group exists 
identically (same 
version)

See the user/group conflict resolution table in the topic Copying 
users and user groups across projects

Yes, user/group exists 
differently (different 
version)

See the user/group conflict resolution table in the topic Copying 
users and user groups across projects
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$FFHVV�FRQWURO�OLVWV�RI�REMHFWV�FRSLHG�DFURVV�UHSRVLWRULHV

An access control list (ACL) is a data element of the MicroStrategy 7 security 
subsystem that defines and enforces the rights of users to access objects. ACLs are 
part of all objects, so they are not copied specifically. The ACL can be found in 
the Security tab of the Properties dialog box for any project-related object.

When an object is copied, its ACL may change in the destination, depending on 
the users and groups existing in the destination:

• If any user or group exists in the source project but not the destination, that user 
or group is eliminated from the destination object’s ACL.

• If all groups and users in the ACL exist in both the source and destination, then 
the ACL is valid for the copied object, and is not changed.

2EMHFW�RZQHUVKLS�RI�REMHFWV�FRSLHG�DFURVV�SURMHFWV�LQ�

GLIIHUHQW�UHSRVLWRULHV

If the owner of a source object does not exist in the destination project, the Object 
Manager user login for the destination project takes ownership of the object if it 
is copied or replaced.

How moving works in MicroStrategy Object 
Manager

An object can be moved only within one project. As with copying, application and 
schema objects are processed differently than are configuration objects.
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Moving application and schema objects within 
projects

MicroStrategy Object Manager behaves exactly as MicroStrategy Desktop does 
when moving application and schema objects within a project. Remember that a 
base object is the object you select from the interface during an object 
management operation.

Object
classification

Destination 
location

Name conflict? Action

Base objects Same as source N/A Warning message 
displayed; cannot 
move object

Different from 
source

Yes, object of same 
name and type 
exists

Warning message 
displayed; cannot 
move object

Different from 
source

No, no name 
conflict

Object moved to 
destination

Base folders Same as source N/A Warning message 
displayed; cannot 
move folder

Different from 
source, and not a 
subdirectory of 
source

Yes, folder of same 
name exists

Warning message 
displayed; cannot 
move folder

Different from 
source, and not a 
subdirectory of 
source

No, no name 
conflict

Folder moved to 
destination

Subdirectory of 
source

N/A Warning message 
displayed; cannot 
move folder

Dependent objects N/A N/A No action

Child objects and 
folders

Remain within base 
folder in destination 
location

N/A No action
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Moving configuration objects

Configuration objects include database instances, schedules, users, and user 
groups. Database instances and schedules cannot be moved within a project. They 
can only be copied.

How deleting works in MicroStrategy Object 
Manager

An object can be deleted only if it does not have parent dependencies and is not a 
system object. 

If an object has parent dependencies, a warning message is displayed with the 
option to search for parents of the object. No child object can be deleted. 

System objects include:

• Administration directory

• Administrator user

• Data Explorer

• Schedule Manager

• The folder My Answers

• The folder My Favorites

• The folder My Objects

• The folder My Personal Objects

• The folder My Reports

Object
classification

Destination 
group

Action

Base user Same as source No action

Different from source Source user membership switched 
from source group to destination 
group

Base group Same as source No action

Different from source Source group membership switched 
from source group to destination 
group

Child users/groups N/A No action
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• The folder System Objects, and folders it contains

• The user group Everyone

• The user group Public

• The user group System Administrators

• User Manager

How renaming works in MicroStrategy Object 
Manager

Most objects can be renamed in Object Manager, but not the following system  
objects: 

• Administration directory

• Data Explorer

• Schedule Manager

• The folder My Answers

• The folder My Favorites

• The folder My Objects

• The folder My Personal Objects

• The folder My Reports

• The user group Everyone

• User Manager

If the new name already exists, MicroStrategy Object Manager prompts you for a 
different name.

To learn about...
...the MicroStrategy Object Manager windows, see the following   
chapters:

• Object Manager window

• Conflict Resolution dialog box

• Object Manager Preferences dialog box

• Object Dependencies window

• Search for Objects dialog box
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...tasks you can perform using MicroStrategy Object Manager, see 
Chapter 7, How do I...?
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Object Manager 
Window

:KDW�LV�LW"

The Object Manager window is the main MicroStrategy Object Manager 
interface; it is also the first window displayed when you log in to MicroStrategy 
Object Manager. The window contains an object browser for each project source 
you select. It is very similar to the MicroStrategy Desktop window, but contains 
added functionality to copy and move objects, among other utilities.

+RZ�GR�,�DFFHVV�LW"

You access the Object Manager window by starting up MicroStrategy Object 
Manager and logging in to a project source.

:KDW�FDQ�,�GR�ZLWK�LW"

You can use the options available on the Object Manager window to

• duplicate projects

• copy and paste objects within a project

• copy and paste objects across related projects

• move objects within a project

• delete objects within a project

• rename objects within a project

• search for objects within a project

• find object parents or children within a project

For a description of the steps to follow when performing the tasks listed, please 
refer to Chapter 7, How do I...?



20 Chapter 2 Object Manager Window

I

N
T
E
R
F
A
C
E

:KDW�VKRXOG�,�NQRZ�EHIRUH�,�XVH�LW"

Before you use MicroStrategy Object Manager, you should familiarize yourself 
with the following topics:

• MicroStrategy Desktop concepts (see the MicroStrategy 7 Getting Started 
Guide)

• Setting up your environment 

• How copying works in MicroStrategy Object Manager 

• How deleting works in MicroStrategy Object Manager 

• How moving works in MicroStrategy Object Manager 

• How renaming works in MicroStrategy Object Manager 

For more information, refer toChapter 1, MicroStrategy Object Manager 
Concepts.

Object Manager window layout
The default view of the Object Manager window, which is the main interface of 
MicroStrategy Object Manager, includes

• an object browser for each project source you selected; each object browser 
contains the following items:

◊ a Location box across the upper part of the object browser, showing the 
project currently selected

◊ a Folder List displayed on the left, showing all the projects to which you 
have access

◊ a display of folder contents on the right; depending on the view selected, it 
may show icons, a list, or a detailed list that includes Name, Type, and 
either Metadata Version columns (for projects) or Modification Time 
columns (for project components)

• a menu bar that in addition to standard Windows NT menus (File, Edit, View, 
Window, and Help) includes a Tools menu that contains MicroStrategy Object 
Manager-specific items

• a toolbar that provides, among other options, the capability to

◊ create a new folder

◊ select projects

◊ view object properties

◊ search for objects
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Object Manager menu bar

The File and Tools menu bar options contain items unique to the Object Manager 
window. The tables that follow describe the contents of each. 

File menu option Function

New Folder Creates a new folder

Properties Displays the Properties dialog box, which, 
for the currently selected object, allows you 
to

• view general properties information 
such as type, location, description (which 
you can update), creation/modification 
date, owner, and access

• change security information such as 
addition/deletion of permission levels, 
access to attribute children, and 
ownership

Tools menu option Function

Search for Objects Opens the New Search dialog box, with 
which you can search for objects by name, 
description, location, creation/modification 
date, type, or ownership

Object Child Dependencies Opens the Child Dependencies dialog 
box and displays all the child objects on 
which the selected object depends

Object Parent Dependencies Opens the Parent Dependencies dialog 
box and displays all the parent objects 
which depend on the selected object

Project Source Manager Opens the Project Source Manager 
dialog box, which shows the name and 
connection mode of every project source 
and allows addition, removal, and 
modification of project source information

Diagnostics Opens the Diagnostics dialog box, from 
which you can select one or more project 
components against which you can run 
diagnostics
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For information on performing any of these operations, see Chapter 7, How do 
I...?

Object Manager toolbar

Of the options available through the menu bar, those most frequently used are 
duplicated on the toolbar, where they are accessible by means of icons. Their use 
is described below.

• Create a new folder: Create a new folder in the current location.

• Open project sources: Select a project from the list displayed when you click 
the Open icon.

• Rename an object: Save an object under a different name, in either the same 
directory or a different one.

• View object properties: View the general properties of the selected object and 
change its security properties.

• Search for objects (within a project): Use the Search Editor to search for 
objects by

◊ name 

◊ description

◊ location

◊ date of creation or revision

◊ type

◊ owner

• Show/hide the folder list: Choose either to display or to hide the folder list for 
a project.

• Refresh the window: Synchronize the window display with the current state 
of the metadata.

• Object child dependencies: Display all the child objects on which the selected 
object depends.

• Object parent dependencies: You can display all the parent objects that 
depend on the selected object.

Object Manager Preferences Opens the Object Manager Preferences 
dialog box, which allows you to select 
browsing options, navigation preferences, 
conflict resolution preferences and their 
default actions, event logging options, 
processing information, and interface 
language

Tools menu option Function
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For information on performing any of the above tasks, see Chapter 7, How do I...?
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Object Manager 
Conflict Resolution 
Dialog Box

:KDW�LV�LW"

The Conflict Resolution dialog box appears if a conflict arises during a copy 
operation. It allows you to review information about the conflict and decide how 
to resolve it. 

+RZ�GR�,�DFFHVV�LW"

You cannot manually access the Conflict Resolution dialog box; it appears only 
if a conflict arises during a copy operation. 

:KDW�FDQ�,�GR�ZLWK�LW"

You can review information about the conflict, such as the name and type of the 
source and destination objects and the nature of the conflict. You can then choose 
from a list of options to resolve the conflict. 

:KDW�VKRXOG�,�NQRZ�EHIRUH�,�XVH�LW"

You should understand how copying works in MicroStrategy Object Manager. 
Refer to Chapter 1, MicroStrategy Object Manager Concepts.

Conflict Resolution dialog box layout
The Conflict Resolution dialog box includes

• a table displaying information about the source and destination objects. The 
table also contains a column labeled Action that allows user input to resolve 
the conflict.

• a menu bar that offers File and Tools options specific to this dialog box, 
including the ability to

◊ view object properties 

◊ proceed with the operation

◊ view object dependencies
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◊ view details of the conflict

• a toolbar containing the most frequently used menu options

The table contains the following columns:

Column name Description

Action A list of the user actions available for this 
type of conflict. Select an action before 
proceeding with the original operation. 
Actions include

• Use Existing

• Replace

• Keep Both

• Use Oldest

• Use Newest

• Update in same path (when copying 
folders)

• Update in new path (when copying 
folders)

• Merge Privileges (when copying 
users/groups)

Name (origin) The name of the source object

Type (origin) The object type of the source object

Path (origin) The directory location of the source object

Modified (origin) The modification date of the source object

Name (destination) The name of the destination object.

Type (destination) The object type of the destination object

Path (destination) The directory location of the destination 
object

Modified (destination) The modification date of the destination 
object

Conflict The type of conflict. These include:

• Exists Identically

• Exists Differently

New Name If the Action is set to Keep Both, you can 
enter a new name for the destination 
object.
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The File and Tools menu bar options contain items unique to the Conflict 
Resolution dialog box. The tables that follow describe the contents of each.

For information on performing any of the previous operations, see Chapter 7, How 
do I...?

File menu option Function

Properties (Origin) Displays the properties of the source object 
and allows you to

• view general properties information such 
as type, location, description (which you 
can update), creation/modification date, 
owner, and access

• change security information such as 
addition/deletion of permission levels, 
access to attribute children, and 
ownership

Properties (Destination) Displays the properties of the destination 
object and allows you to

• view general properties information 
such as type, location, description (which 
you can update), creation/modification 
date, owner, and access

• change security information such as 
addition/deletion of permission levels, 
access to attribute children, and 
ownership

Tools menu option Function

Proceed Continues the operation

Object child dependencies Displays the children of the source object in 
the Child Dependencies dialog box

Object parent dependencies Displays the parents of the source object in 
the Parent Dependencies dialog box

Details Displays details of the conflict
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Of the options available through the menu bar, those most frequently used are 
duplicated on the toolbar, where they are accessible through icons. They work as 
follows:

• Proceed continues the original operation once you have set the action

• Object child dependencies allows you to view the children objects of the 
source object

• Object parent dependencies allows you to view the parent objects of the 
source object

• Help allows you to access the online help 

For information on performing any of these tasks, see Chapter 7, How do I...?
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Object Manager 
Preferences Dialog 
Box

:KDW�LV�LW"

The Object Manager Preferences dialog box is a tool with which you can 
customize the appearance and behavior of objects displayed on the MicroStrategy 
Object Manager user interface.

+RZ�FDQ�,�DFFHVV�LW"

You can access the Object Manager Preferences dialog box from the Tools menu 
of the Object Manager window.

:KDW�FDQ�,�GR�ZLWK�LW"

You can use the Object Manager Preferences dialog box to customize

• browsing options

• navigation preferences

• whether to warn before deleting an object

• conflict resolution preferences

• conflict resolution default actions

• event logging options

• interface languages

The Conflict Resolution and Events tabs contain options unique to 
MicroStrategy Object Manager. See the following topics for more information:

• Conflict Resolution tab 

• Events tab 

The remaining options work the same as in MicroStrategy Desktop. Please refer 
to the MicroStrategy 7 Getting Started Guide for more information on those 
options.
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Conflict Resolution tab

When you select Conflict Resolution in the Object Manager Preferences dialog 
box, you can specify

• whether to display the type, modification time, and path of the origin and 
destination object in the Conflict Resolution dialog box

• the default action to use during a copy conflict of objects, folders, and users and 
user groups

For information on using the Conflict Resolution tab of the Object Manager 
Preferences dialog box, see the following topics in Chapter 7, How do I...?:

• Customize Conflict Resolution default actions 

• Customize Conflict Resolution preferences 

Events tab

When you select the Events tab in the Object Manager Preferences dialog box,  
you can specify whether to log events to a file, and the name and location of the 
log file.

For information on using the Events tab of the Object Manager Preferences 
dialog box, see the following topics in Chapter 7, How do I...?:

• Customize copy status data 

• Enable event logging 
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Object Manager Object 
Dependencies 
Window

:KDW�LV�LW"

The Object Dependencies window displays the parents or children of the selected 
object.

+RZ�GR�,�DFFHVV�LW"

You can access the Object Dependencies window by selecting an object and 
choosing Object children dependencies or Object Parent dependencies from the 
Tools menu in the Object Manager window. 

:KDW�FDQ�,�GR�ZLWK�LW"

You can display the parents or children of the selected object, and view their 
properties and dependencies. You can also switch between the parents and 
children views without closing the Object Dependencies window.

For information on using the Object Dependencies window, see the following 
topics in Chapter 7, How do I...?:

• Find children dependencies

• Find parent dependencies

:KDW�VKRXOG�,�NQRZ�EHIRUH�,�XVH�LW"

Before you begin using the Object Dependencies window, you should understand 
the concepts of parent and child objects. For more information, please see the 
following topic in Chapter 1, MicroStrategy Object Manager Concepts:

• How copying works in MicroStrategy Object Manager

Object Dependencies window layout
The Object Dependencies window displays the object you selected in the Object 
Manager window and, depending on the menu option you selected from the 
Object Manager window Tools menu, a list of that object’s parents or children. 



32 Chapter 5 Object Manager Object Dependencies Window

I

N
T
E
R
F
A
C
E

The File menu and Tools menu include options specific to the Object 
Dependencies window. The tables that follow describe the functions of these 
unique menu options.

Of the options available through the menu bar, those most frequently used are 
duplicated on the toolbar, where they are accessible through icons. In addition to 
the Tool menu options listed above, the toolbar includes the View object 
properties button, which displays the properties of selected objects.

For information on using the Object Dependencies window, see the following  
topics in Chapter 7, How do I...?:

• Find children dependencies 

• Find parent dependencies

File menu option Function

Properties Displays the properties of the selected 
object and allows you to

• view general properties information 
such as type, location, description (which 
you can update), creation/modification 
date, owner, and access

• change security information such as 
addition/deletion of permission levels, 
access to attribute children, and 
ownership

Tools menu option Function

Collapse All Collapses the whole hierarchy so that only 
the originally selected object is displayed

Object child dependencies Displays the child objects of the selected 
object in another Child Dependencies 
dialog box

Object parent dependencies Displays the parent objects of the selected 
object in another Parent Dependencies 
dialog box
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Object Manager 
Search for Objects 
Dialog Box

:KDW�LV�LW"

The Search for Objects dialog box is a tool you can use to search for either a 
specific object or a group of objects meeting certain criteria. To perform a search, 
you use a special type of MicroStrategy object called a search engine.

You can select multiple criteria to search for an object. For example, you can look 
for objects according to their type, the date on which they were last modified, and 
their owners. The larger the number of criteria you use for searching, the more 
restricted the result of your search becomes, and the smaller the number of objects 
meeting those criteria.

+RZ�GR�,�DFFHVV�LW"

You can access the Search for Objects dialog box directly from the Object 
Manager window by selecting Search for Objects from the Tools menu.

:KDW�FDQ�,�GR�ZLWK�LW"

You can use the Search for Objects dialog box to perform searches based on one 
or more of the following criteria:

• name

• description

• location

• creation/modification date

• object type

• ownership

For a description of the procedures to follow when searching for an object, please 
refer to the following topics in Chapter 7, How do I...?:

• Search for an object by date

• Search for an object by name and location

• Search for an object by object type
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• Search for an object by owner criteria

6HDUFK�XVDJH

The Search for Objects dialog box provides two options to initiate a search:

• Find Now generates a search based on parameters you have entered. When you 
use this option, the system shows a list of all the items meeting the criteria for 
those parameters. 

• New Search clears the contents of the current search. When you use this 
option, the system prompts you to confirm deletion before you initiate a new 
search. 

You can search for and select objects that meet specific criteria:

• name and location; for example, “Mid-Atlantic” located in the folder “Region”

• date or time interval during which they were created or last modified; for 
example, “all objects modified between 03/22/99 and 04/14/00”

• type; for example, “Attribute” or “Metric”

• owners; for example, “Administrator” or “John Smith”

The following topics describe the contents and function of each tab.

1DPH�	�/RFDWLRQ�VHDUFKHV

Name & Location provides spaces where you can enter an object name, 
description, and location, allowing you to search for objects when you know their 
identity. 

1RWH��You can perform a search using any one of the three identifiers in this tab 
(Named, Description, or Look in); however, single-criterion searches of this type 
may have an impact on performance, because the search can be extensive.

'DWH�VHDUFKHV

Date offers several time-interval search criteria, allowing you to search for objects 
when you know the time interval during which they were created or last modified.

2EMHFW�7\SHV�VHDUFKHV

Object Types provides a list of all existing object types in a project, allowing you 
to search for objects when you know their type.
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2ZQHU�VHDUFKHV

On the Owner tab you can select a search object when you know its owner.
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How do I...?

Copy (duplicate) a project

6WHSV

�� In the Object Manager window, click on the project to be copied.

�� Drag the selected project to a project source icon and drop it.

Copy a user or group

6WHSV

�� In the Object Manager window, do one of the following:

◊ Right-click the user or group to copy and select Copy from the pop-up 
menu.

◊ Select the user or group and click the Copy icon in the toolbar.

◊ Select the user or group and choose Copy from the Edit menu.

�� Do one of the following:

◊ Right-click the destination and select Paste from the pop-up menu. 

◊ Select the destination and click the Paste icon in the toolbar.

Select the destination and choose Paste from the Edit menu.

If the Conflict Resolution dialog box opens, the object cannot be duplicated 
without user interaction. Refer to the following topic:

 Resolve a conflict when copying a user or group

�� Progress status is displayed. When the copy process is complete, click Close 
to return to the Object Manager window. 

�� You may need to click Refresh on the Object Manager toolbar to see the 
changes.
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1RWH

For more information on copying, see the following Chapter 1 topic:

How copying works in MicroStrategy Object Manager

Copy an object

6WHSV

�� In the Object Manager window, do one of the following:

◊ Right-click the application or schema object to copy and select Copy from 
the pop-up menu.

◊ Select the source object and click the Copy icon in the toolbar.

◊ Select the source object and choose Copy from the Edit menu.

�� Do one of the following:

◊ Right-click the destination and select Paste from the pop-up menu. 

◊ Select the destination and click the Paste icon in the toolbar.

◊ Select the destination and choose Paste from the Edit menu

If the Conflict Resolution dialog box opens, the object cannot be duplicated 
without user interaction. Refer to the following topic:

Resolve a conflict when copying  objects

�� Progress status is displayed. When the copy process is complete, click Close 
to return to the Object Manager window.  

�� You may need to click Refresh on the Object Manager toolbar to see the 
changes. 

1RWH

For more information on copying, see the following Chapter 1 topic:

How copying works in MicroStrategy Object Manager

Create a new Object Manager folder

6WHSV

�� In the Object Manager window, select where you want the new folder.
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�� Do one of the following:

◊ From the File menu, select New folder.

◊ Click the New folder icon on the toolbar.

�� Enter the name of the new folder.

Customize Conflict Resolution default actions

6WHSV

�� Select Tools from the Object Manager window menu bar.

�� From the Tools menu, select Object Manager Preferences. The Object 
Manager Preferences dialog box opens.

�� Select the Conflict Resolution tab.

�� Click Set Default Actions. The Default Object Actions dialog box opens.

�� For each type of object, select the action to appear as the default when the 
corresponding Conflict Resolution dialog box opens. Click OK when you have 
completed your selections.

�� Click OK in the Object Manager Preferences dialog box to return to the 
Object Manager window.

Customize Conflict Resolution preferences

6WHSV

�� Select Tools from the Object Manager window’s menu bar.

�� From the Tools menu, select Object Manager Preferences. The Object 
Manager Preferences dialog box opens.

�� Select the Conflict Resolution tab.

�� Under Conflict resolution preferences, select the check box for the 
information you want displayed in the Conflict Resolution dialog box.

�� Click OK.

Delete an object

6WHSV

�� In the Object Manager window, select the object to be deleted.
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�� Do one of the following:

◊ From the File menu, select Delete.

◊ Click the Delete the object selected icon on the toolbar.

1RWHV

• If the object has parent dependencies, a warning message will appear with an 
option to search for them. 

• An object cannot be deleted if it is a system object or if it has parent 
dependencies. 

Enable event logging

6WHSV

�� Select Tools from the Object Manager window’s menu bar.

�� From the Tools menu, select Object Manager Preferences. The Object 
Manager Preferences dialog box opens.

�� Select the Events tab.

�� Under Options, select the Log events to file check box. 

�� Specify a text file name and folder location for the event log.

�� You can select Show objects without conflicts to log all Object Manager 
actions.

�� Click OK.

Find child dependencies

6WHSV

�� In the Object Manager window, select the parent object.

�� From the Tools menu, select Object child dependencies. The Object 
Dependencies window opens.

�� To expand an object, click it. 

�� To close an expanded object, click it. To collapse the entire hierarchy down 
to the original selected object, click Collapse All on the toolbar.

�� To switch to parent objects view, click Object Parent Dependencies on the 
toolbar. A second Object Dependencies window opens, displaying the selected 
object’s parent dependencies. 
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�� To view object properties, select the object and click View Object 
Properties on the toolbar.

Find parent dependencies

6WHSV

�� In the Object Manager window, select a child object.

�� From the Tools menu, select Object parent dependencies. The Object 
Dependencies window opens.

�� To expand an object, click it. 

�� To close an expanded object, click it. To collapse the entire hierarchy down 
to the original selected object, click Collapse All on the toolbar.

�� To switch to children objects view, click Object Child Dependencies on the 
toolbar. A second Object Dependencies window opens, displaying the selected 
object’s children dependencies.

�� To view an object’s properties, select it and click View Object Properties 
on the toolbar.

Move an object

6WHSV

�� In the Object Manager window, do one of the following:

◊ Right-click the object to be moved and select Move from the pop-up menu. 

◊ Select the source object and click the Move icon in the toolbar.

◊ Select the source object and choose Move from the Edit menu. 

�� Do one of the following:

◊ Right-click the destination and select Paste from the pop-up menu. 

◊ Select the destination and click the Paste icon in the toolbar.

◊ Select the destination and choose Paste from the Edit menu.

1RWHV

An object cannot be moved if an object of the same name and type already exists 
in the destination folder, or if the destination folder is the same as the source 
folder. Database instances and schedules cannot be moved. 
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For more information on moving, see the following Chapter 1 topic:

• How moving works in MicroStrategy Object Manager 

Open a project source in Object Manager

6WHSV

�� From the Object Manager window File menu, choose Open. The Open 
Project Source dialog box opens.

�� Select the project sources to open and click Open. The Login dialog box 
opens. 

�� Enter a valid login ID and password. You should log in with administrator 
privileges, which ensures that you will have the rights to copy, create, delete, and 
move objects.

1RWH

MicroStrategy Object Manager is based on the MicroStrategy 7.0 security model. 
Therefore, all activities that may be performed in MicroStrategy Object Manager 
are governed by user privileges and access control lists. For example, an object 
cannot be copied if you, as a user, do not have write privileges to the destination 
folder. 

Rename an object

6WHSV

�� Do one of the following:

◊ Right-click the object to be renamed and select Rename from the pop-up 
menu.

◊ Select the object and click the Rename icon in the toolbar.

◊ Select the object and choose Rename from the Edit menu.

�� Enter the new name.

1RWH

An object can be renamed only if it is not a system object.
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Resolve a conflict when copying a user or group
The Conflict Resolution dialog box opens when MicroStrategy Object Manager 
determines that the Copy function cannot be completed without user intervention. 
If it opens during a user or group copy, the Conflict column is set to Exists 
Differently, which indicates that the user or group exists in the destination in a 
different version, meaning they are not identical.

6WHSV

�� Choose an action from the following list to resolve the conflict:

◊ Use Existing: The item is not copied. No changes are made either to the 
source or the destination items. 

◊ Replace: The destination object definition is replaced with the source object 
definition. If the destination group is not included in user memberships, it is 
added to the memberships. 

◊ Merge Memberships: The membership information of the destination item 
is modified to reflect the current content of both the source and the 
destination. This information includes the destination group only if it is not 
already included in the destination memberships. 

�� Click Proceed to start the copying procedure. 

1RWH

For more information on copying, see the following Chapter 1 topics:

• How copying works in MicroStrategy Object Manager 

• Copying configuration objects within a project 

• Copying users and user groups across projects 

Resolve a conflict when copying objects
The Conflict Resolution dialog box opens when MicroStrategy Object Manager 
determines that the copy function cannot be completed without user intervention.

6WHSV

�� Refer to the Conflict column.

◊  If Conflict is set to Exists Identically, the source and destination objects 
are identical, meaning that they are the same version. Choose an action from 
the following list:

– Use Existing: The object is not copied. No changes are made either to the 
source or the destination objects. 
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– Keep Both: The destination object is not changed. MicroStrategy Object 
Manager duplicates the source object in the destination location. You can 
specify a name for the new object, if you desire, by typing it in the New 
Name column. 

– Update destination folder in Same Path: This option is provided only 
when a folder is being copied. The destination folder remains in the 
original location and is updated with any new objects being copied.

– Update destination folder in New Path: This option is provided only 
when a folder is being copied. The folder moves to the new destination 
location and is updated with any new objects being copied. 

◊ If Conflict is set to Exists Differently, the source object exists in the 
destination in a different version, meaning the source and destination 
objects are not identical. Choose an action from the following list:

– Use Existing: The object is not copied. No changes are made either to the 
source or the destination object. 

– Replace: The destination object is replaced by the source object. If the 
object to be copied is the base object (the object you selected to copy), 
MicroStrategy Object Manager checks the folder location before 
replacing the destination object. If the specified destination folder is the 
same as the current location, Object Manager replaces the destination 
object with the source object. If it is different, Object Manager replaces 
the destination object with the source object and moves the destination 
object to a new location. 

– Keep Both: The destination object is not changed; instead, the source 
object is duplicated in the specified destination location. You can specify 
a name for the new object, if you desire, by typing it in the New Name 
column. 

– Use Older: If the source object is newer than the destination object, the 
object is not copied. The operation is the same as Use Existing. If the 
destination object is older than the source object, the destination object 
is replaced by the source object. This operation works like Replace. 

– Use Newer: If the source object is newer than the destination object, the 
destination object is replaced by the source object. This operation works 
like Replace. If the source object is older than the destination object, the 
object is not copied. The operation is comparable to Use Existing. 

�� Click Proceed to start the copying procedure.

Search for an object by date

6WHSV

�� From the Object Manager window Tools menu, select Search for Objects. 
The Search for Objects dialog box opens.
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�� Select the Date tab.

�� Click Find all objects and select either Modified or Created (the default 
value is Modified), then select one of the following:

◊ between __ and__ , and enter a begin date and an end date to search for an 
object that was either modified or created during the specified interval

◊ during the previous __ days to search for an object that was either 
modified or created during the specified number of days prior to the current 
date

◊ during the previous __ months to search for an object that was either 
modified or created within the specified number of months prior to the 
current date

�� Click Find now. The system shows a list of objects that meet the criteria you 
specified.

Search for an object by name and location

6WHSV

�� From the Object Manager window Tools menu, select Search for Objects. 
The Search for Objects dialog box opens.

�� Select the Name & Location tab.

�� Do one of the following:

◊ Enter the name, description, and location of the search object, and check 
whether you want the search to include subfolders associated with the 
project.

◊ Use the Named field’s drop-down menu to select an object name.

�� Click Find now. The system displays a list of objects that meet the criteria 
you specified.

Search for an object by object type

6WHSV

�� From the Object Manager window Tools menu, select Search for Objects. 
The Search for Objects dialog box opens.

�� Select the Object Type tab.

�� Highlight the type of object to be identified.
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�� Select Only these types of objects and click Find now. The system displays 
a list of objects of the type you selected.

Search for an object by owner

6WHSV

�� From the Object Manager window Tools menu, select Search for Objects. 
The Search for Objects dialog box opens.

�� Select the Owner tab. The Owner tab opens, listing all owners.

�� Highlight an owner.

�� Select Only this owner and then click Find now. The system displays all 
the objects that belong to the specified owner.
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